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24.7 Help
25 Troubleshooting

Installation
ProVideoPlayer 2 is only available for download on the Renewed Vision website. Go to RenewedVision.com
(http://www.renewedvision.com/pvp_download.php) to download the latest version of PVP 2. When you install PVP 2,
you will be able to register the program or run it in a watermarked demo mode.

(/pvp2wiki/index.php?title=File:PVPpage.png)

After you download PVP 2, locate the disk image in your Downloads folder. Open this disk image, and double-click on the
included file to run the installer. You will be prompted to agree to the license terms and then to drag ProVideoPlayer 2
into your Applications folder.

(/pvp2wiki/index.php?title=File:Pvpdmg.png)

After you have agreed to the License terms, you will see the screen below. Drag the PVP 2 icon to the Applications icon.
This will install PVP 2 to your system Applications folder. If you need to install the program in a different location, open a
separate Finder window and move ProVP 2 to the correct destination. Eject the Disk Image after you have installed the
program by dragging the Disk Image icon on your Desktop to your Trash Bin, clicking the Eject button next to the Disk
Image name in Finder, or by pressing Command-E from the installer screen.

http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Help
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(/pvp2wiki/index.php?title=File:Pvp2installer.png)

System Requirements
While the software may work on systems that do not meet these requirements, those systems will not be supported. As
always, you will be able to download the software at no charge to test performance on any computer.

ProVideoPlayer 2 (minimum Mac specifications)

Processor: 64-Bit Intel Core 2 Duo processor or better
OS: MacOS X 10.8 (Mountain Lion) or later
RAM: 4 GB RAM

NOTE: For heavy or advanced use of video (i.e. multiple video clips per slide, HD content, etc.), a faster system is
advised.

ProVideoPlayer 2 is a 64-bit application. This means the program is no longer limited to a maximum of 4GB of RAM. You
can install up to 16TB of RAM (or more) and PVP 2 could, in theory, use it. The ability to access more RAM means that
the program can perform many operations must faster than before. This allows us to build a much more powerful
program that can take full advantage of the system it is installed on. However, before you go and install as much RAM as
you can afford, keep in mind that ProVideoPlayer 2 runs very efficiently and is very unlikely to need a significant amount
of RAM.

Registering ProVideoPlayer 2
If PVP 2 is unregistered, you will be prompted to register, purchase, or run the program as a demo. If you have purchased
a license, enter the registration name and code that was sent to you, including the dashes, and click Submit. The entire
code will be visible during this process, so double check your code before clicking Submit.

(/pvp2wiki/index.php?title=File:Pvp2registration.jpg)
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If the code was taken successfully, you'll be prompted for your user password. This is your computer user account
password.

(/pvp2wiki/index.php?title=File:Pvp2registrationsuccess.jpg)

Once the program is registered, you'll be able to see the registration name and the first and last five digits of the code,
but you will not be able to see the entire code. The partial code can be used by a Renewed Vision employee to look up
your account records if needed in the future. To access this information, click on the ProVideoPlayer 2 menu in the menu
bar, and click on "Registration".

If you need to transfer your license from one computer to another, come to this screen and click the "Unregister" button.
You will then be able to use the same code on another Mac running PVP 2.

(/pvp2wiki/index.php?title=File:Pvp2registrationinfo.jpg)

If you want to test PVP 2, click on the "Try It" button to open PVP 2. There will be a watermark on the output screen, but
the program is fully functional otherwise. If you are ready to purchase PVP 2, click the Purchase button and go through
the checkout process.

Setup Wizard
The very first time you open ProVideoPlayer 2 you will be guided through the Setup Wizard. The Setup Wizard allows you
to define the number of screens and the basic arrangement of those screens.

(/pvp2wiki/index.php?title=File:Wizardstartscreen.jpg)

The Setup Wizard guides you through configuring your output screens for ProVideoPlayer 2. This is especially useful if
you have multiple displays attached, need to get a grid layout started, or need to setup edge blending. Click on the
"Help" menu at any time to access the Setup Wizard.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:Pvp2registrationsuccess.jpg
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The first configuration is the most basic. It shows one external display attached. You want to make sure the output screen
is assigned properly by clicking on the dropdown menu and picking the output you want to assign to that display.

(/pvp2wiki/index.php?title=File:Wizardbasic.png)

If you have more than one screen attached, update the number of screens and then press Tab or Enter to confirm the
change. You will see the number of screens indicated change as well. Repeat the steps of assigning each screen. One of
the great features of PVP 2 is the ability to configure displays that don't exist yet. If you are programming for a show and
don't have the ability to setup all of your screens, simply leave the display assigned to "Assign later..." and continue
working.

Now that you have more than one screen, you can change the arrangement. You have the options for Horizontal (default),
Vertical, Grid, Horizontal Edge Blend, or Vertical Edge Blend. You can see these different layouts shown below.

(/pvp2wiki/index.php?title=File:SetupWizardHorizontal.jpg)
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(/pvp2wiki/index.php?title=File:SetupWizardVertical.jpg)

(/pvp2wiki/index.php?title=File:SetupWizardGrid.jpg)

The Edge Blend arrangements give you a few additional options to help you get your blend setup correctly. For the
"Physical Screen Size" you can enter this as the number of screens (5 wide, 1 tall) or physical measurements. Round up
or down if you are entering this value as feet/inches/meters/centimeters. The unit of measurement doesn't matter as long
as you use the same unit.

The "Projector Resolution" value is the actual resolution of one projector. In the example below, the projector outputs
1024x768. This resolution must be the same for each projector. The rest of the numbers are calculated automatically. As
you change your numbers, you will see the screen guides changing to show you the overlap. FIXME

http://support.renewedvision.com/pvp2wiki/index.php?title=File:SetupWizardVertical.jpg
http://support.renewedvision.com/pvp2wiki/index.php?title=File:SetupWizardGrid.jpg
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(/pvp2wiki/index.php?title=File:SetupWizardHorizontalBlend.jpg)

(/pvp2wiki/index.php?title=File:SetupWizardVerticalBlend.jpg)

After you have selected the basics of your layout, click the "Next" button to continue with the Setup Wizard.

The next screen will help you create the different layers. One layer is created automatically for you. You can add
additional layers and choose how those layers should be handled. Keep in mind that layers that overlap will be hidden by
the topmost active layer. Working with layers will be covered in much more detail later. Once you have setup your layers,
click the "Done" button to go to the workspace.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:SetupWizardHorizontalBlend.jpg
http://support.renewedvision.com/pvp2wiki/index.php?title=File:SetupWizardVerticalBlend.jpg
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Interface

(/pvp2wiki/index.php?title=File:Pvp2gui.png)

When you first open PVP 2, you will see a similar interface to the one shown in the above image, although sections #4
and #5 are not shown by default. Also not shown in this screenshot is the menu bar at the top of your screen. The menus
are covered in a later section. For now, we're just covering the primary sections of the program you'll interact with on a
regular basis.

1. The first three buttons in the toolbar are the Clear commands. Clear All stops and clears anything playing in PVP 2.
Clear Layer clears only the selected Layer, while leaving the others alone. Clear Text is only shown if you have Text
Stream enabled in the Preferences.

2. The left column of the main interface is where all of your playlists get stored. This column will always have Library and
Live Video at the top. Below that, you can add Group Folders, Playlists, and Hot Folders.

3. Click on the Action Menu (icon with the gear and down arrow) to add Group Folders, Playlists, and Hot Folders. You
can also add new Playlists from the File menu.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:SetupWizardTargetBehavior.jpg
http://support.renewedvision.com/pvp2wiki/index.php?title=File:Pvp2gui.png
http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Text_Stream
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http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Playlists
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4. As mentioned, this section is not shown by default. To enable the Layers view, press Command-L or select it from the
View menu. When you have multiple Layers, this section can be scrolled left and right. From left to right, the lefts
arranged bottom to top. The selected layer will have a thicker outline color. You can click the Edit button to open the
Layout Editor.

5. The Select Look button is also not shown by default. This can added to the interface by pressing Option-L or selecting
it from the View menu. Refer to the Looks section for more information.

6. The [[#Network}Network]] button allows you to see what other computers are available to network with. Read more
about this in the [[#Network}Network]] section.

7. The Manual button enables Manual Mode. In Manual Mode, you can blend two videos or images (or one of each)
together in real-time. You will need to be on the Layer Viewer to use control the blend.

8. The Viewer shows you either the Workspace, which is what your audience sees, or the Layer that is selected. If you
are using video, the playback controls will allow you to control the video.

9. This is the list of available effects for your Workspace and Layers. Read more about this in the Media Effects section.
10. Click the plus button to add new files to your current Playlist. If you are on the Live Video Playlist, this will prompt you

for a video input.
11. You can build a Macro to trigger multiple clips on multiple Layers.
12. Select the Transition you want to use.
13. Search for files that have been added to your Playlist.
14. Change the size of the thumbnails.

Preferences
General

(/pvp2wiki/index.php?title=File:Generalpreferences.jpg)

The General Preferences allow you to set a few global behaviors for ProVideoPlayer 2.

We recommend leaving "Automatically Check for Updates" enabled so that you will know as soon as possible when an
update is available. Updates include bug fixes and often address reported crashes, which will increase the stability of the
program on your computer. There may also occassionally be new features or feature enhancements added by an update.
Each update includes a list of changes so that you can decide whether or not you want to install a particular update.
However, there may be reasons why you need to limit the program from checking for updates automatically. If this is the
case, uncheck this option, and then click on the "Check for Updates" button to manually check for new updates.

The "Default Scale Behavior" includes Scale to Fit, Scale to Fill, and Stretch to Fill. Scale to Fit will maintain the file's
aspect ratio and may leave black bars on the sides of a file if it does not match the output resolution. Scale to Fill zooms
an image until the screen is filled; this will result in the image being cropped on two sides. Stretch to Fill ignores a file's
aspect ratio and stretches it so that the entire output screen is filled with content. This may result in some distortion of
your file.

http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Layers
http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Looks
http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Media_Effects
http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Macros
http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Transitions
http://support.renewedvision.com/pvp2wiki/index.php?title=File:Generalpreferences.jpg
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If you have cameras connected to your Mac and need to be abel to access them through ProVideoPlayer 2, be sure to
check the "Show Live Video Playlist". Be sure to check out the Live Video section for more information about using
cameras with PVP 2.

The "Manage Media" option allows you to add media to ProVideoPlayer 2 without worrying about where it is located. You
can still maintain your own organization system while using managed media. This option does not duplicate files. It uses a
file method known as "hard links" to create a a reference to the data on the hard drive. The original file path is also a hard
link to the same data. This allows you to add or remove files in PVP 2 without worrying about your files. These files are
stored in the Shared folder in the Finder and organized within the ProVideoPlayer Media folder.

(/pvp2wiki/index.php?title=File:ProVideoPlayerMedia.jpg)

"Show Detailed Thumbnails" turns the timecode display on thumbnails on and off.

If you choose to not use "Manage Media", you may eventually find a bunch of files that say "Not Found". This is caused
by two things: (1) The source file was deleted; (2) The source file was moved. A source file is considered moved when the
file path is no longer the same, which could be caused by renaming a folder or moving files around. If this happens, you
can manually add a new search path for PVP 2 to look in to try to find the source files that it needs to reconnect media.
Most times this will work. However, if you've made significant changes to your file structure, this method may not work.
File paths get checked on startup, so after adding files paths, restart PVP 2.

You can define how many seconds you want still images to be shown before advancing automatically. Since all files are
added with "Go To Next" as the default behavior, you need to define the time for still images. By default, this is set to five
(5) seconds.

Network

(/pvp2wiki/index.php?title=File:NetworkPreferences.jpg)

http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Live_Video
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You can turn Master or Slave settings on and off, name the computer, and set the port that needs to be used. If you do
not set a name, the computer's name will be used automatically. The port number also generally never has to be
configured.

How to use Ports:

The only time you should need to manually configure the port number is if you are using a firewall or your router is
configured to block/filter traffic. In this case, your network administrator should be able to give you the proper port
information to get through. Your port range will be between 1024 and 65535.

Ports 1-1023 are "Well-known ports" are and used for system processes. You cannot/should not use these in general.
Ports 1024-49151 are registered ports that are known to be used by specific vendors. However, if you don't use the
vendor's product, the port is available. Ports 49152 to 65535 are considered dynamic/private ports, and are the best
location to route your traffic if you do need to use custom ports. (More info: http://en.wikipedia.org/wiki/Registered_port
(http://en.wikipedia.org/wiki/Registered_port))

Text Stream is discussed in more detail in a separate section of this guide. This is where you turn this function on and off.

"Enable Syphon Server" allows PVP 2 to interact with third-party applications that can significantly enhance what you can
do with your outputs. We have attempted to build a tremendous amount of power and flexibility in ProVideoPlayer 2, but
we recognize that often there are specific needs that we can't accommodate in our software directly. That's why PVP 2
has implemented Syphon support. Syphon is an open-source protocol that allows us to share our graphics output with
other programs that can take these images and manipulate them directly... all on the same computer. You can choose
from any one of your screen outputs of PVP 2 as a socket for use by other Syphon-enabled applications. You can read
more about Syphon here (http://syphon.v002.info/) as well as explore some of the third-party applications that are
available. At this time, the Syphon server only sends content from PVP 2 to third-party applications. It cannot receive data
via Syphon. When you have the Syphon Server enabled, you can continue using PVP 2 as you normally would. We
cannot provide support for using Syphon programs. You will need to contact the developers of those applications directly
if you need assistance using their programs.

Communications

(/pvp2wiki/index.php?title=File:CommunicationPreferences.jpg)

The Communications settings allows PVP 2 to interface with various switchers and lighting consoles. PVP 2 can interface
via: AMP, DMX, GVG100, MIDI, RossTalk, Sony BVS, Sony BVW, and VDCP. Communications provides connectivity to
external devices via network or serial communications according to what the protocol supports.

A working knowledge of the protocol you need to use is strongly recommended as each protocol has various options
available and they are not covered in great detail in this guide. Due to the variety of configurations for these protocols, we
are only able to offer limited support. Protocol specifics should be available in product manuals or from hardware
manufacturers for the devices you are interfacing with. 

Playback Deck/Media Server Control Protocols

These protocols include AMP, VDCP, and Sony BVW. AMP and VDCP are media server protocols that have more
capabilities than Sony BVW such as triggering clips by name. BVW can only control the playback of an already triggered
clip.

http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Networking.2FContent_Management
http://en.wikipedia.org/wiki/Registered_port
http://support.renewedvision.com/pvp2wiki/index.php?title=Contents#Text_Stream
http://syphon.v002.info/
http://support.renewedvision.com/pvp2wiki/index.php?title=File:CommunicationPreferences.jpg
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Switcher Control Protocols

These protocols include GVG100, Sony BVS, and RossTalk. These protocols can control a switcher, allowing you to
remotely enable and disable keys or fade to black.

Sony BVS is preferred over GVG100 when available since it has greater capabilities.

RossTalk is a proprietary protocol supported by some Ross switchers. RossTalk is the preferred choice for a compatible
Ross switcher because it uses network communication rather than serial. RossTalk is supported as 2 modes, Device and
Controller. In Controller mode, PVP 2 can send commands to a connected Ross switcher. In Device mode, RossTalk
provides some control of PVP 2 from a compatible Ross switcher. For Device mode, the Ross switcher is setup to
connect to PVP 2 as if it were an Expression CG machine. Once connected, Up/Down on the switcher will advance
through the items of the selected  playlist, and next will trigger slides or videos just like pressing the spacebar/right arrow
key on  the PVP 2 machine. Note that if you want to use both Controller and Device modes for RossTalk, you must
configure two RossTalk devices, one for each mode as these modes require two different network connections.

You can also clear the output using the Clear Layer command where the layers correspond to the different PVP 2 clear
commands as follows:
Layer 0 Clear All
Layer 1 Clear Live Video
Layer 2 Clear Background
Layer 3 Clear Slide
Layer 4 Clear Props

To add any of the available protocols to PVP 2, click on the Add Device button in the lower right corner and select the
protocol from the list. Each protocol has unique configuration settings. We have set each protocol to use the standard
configuration as specified by each manufacturer. If your configuration requires different settings you will need to refer to
the documentation for the device you are connecting to. The screenshot below shows VDCP as an example.

(/pvp2wiki/index.php?title=File:CommVDCP.jpg)

After you have added a protocol, you will see a box that shows you the active protocols. You can connect or disconnect
any protocol, or remove it, from here. If you need to change the settings for a protocol, click on the gear icon to open the
settings menu. The red or green light indicates the off/on status of a particular protocol.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:CommVDCP.jpg
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Click on Midi Setup or DMX Setup to modify these protocols.

The screenshot above shows several of the protocols listed at the same time. PVP 2 is capable of supporting more than
one protocol at the same time, within reason. Some protocol combinations don't make sense to run at the same time, like
AMP and VDCP, but some do like AMP and RossTalk. 

DMX

The DMX configuration allows you to define the starting channel and displays how the other channels are mapped. DMX
supports ArtNet over a network only. USB-DMX interfaces are not supported. The screenshots below show a standard
DMX setup. These values are entered by clicking on the DMX Setup button in the Communication Module. The two
images below show part of the options available for DMX controls. There are too many options to show in a single
screenshot.

(/pvp2wiki/index.php?title=File:DMXoptions.jpg)
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In the Communication preference pane you can setup devices which persist in PVP 2 until you remove them. They may
optionally automatically reconnect when PVP 2 is relaunched. From this preference pane you can also configure the DMX
and MIDI options. In addition, there's a checkbox for whether to allow filenames longer than eight characters for VDCP
and AMP.

VDCP and AMP require a playlist to be designated as the Comm Module playlist. This is the playlist that is used to select
clips with either of these protocols. You can designate any Video/Image Bin playlist as your Comm Module playlist by
right-clicking on the playlist name. The display name of each video in this playlist must be unique and will be modified as
necessary to make it unique. If the eight character filename option is checked, the display name will also be trimmed to
eight unique characters as necessary. Consult your video switcher's manual to determine whether you need to enable the
8 character filename limit. If the switcher doesn't support variable length filenames, then you'll need to enable that option
in PVP 2.

For a switcher control protocol, an option will appear in the contextual menu of any slide to add a switcher control cue to
that slide. Any time that slide is triggered, the chosen command is sent to the switcher if it's connected.

Assigning module commands to slides

When you have enabled a protocol that supports sending commands, you will be able to assign those commands to
specific slides. Each protocol supports different cue options, so the menu that you see will be different. If you only have a
single protocol assigned, you will not have the sub-menu of protocols. GVG100, RossTalk (Controller mode), and Sony
BVS are the only protocols that have slide cues available.  Using RS-422 Serial with Communications Module

RS-422 is a serial standard that defines how the serial signal is transmitted electronically. There are several serial
standards including RS-232 and RS-485. Note that these standards are electrically different and are not compatible even
though in many cases they use the same DB-9 connector. Unfortunately, there are different, incompatible ways that RS-
422 may be wired through a standard DB-9 connector. There are two common DB-9 pinouts that are used with RS-422 in
the context of video production equipment. Depending on your computer serial interface, you may be required to create a
cable or use adapters to convert from one pinout to another. In addition, you may have to compensate for a pinout on a
serial interface that doesn't match either of these common pinouts.

Here are the two common pinouts:

Deck Control Slave
DB-9, usually Female
Pin 1 -> Ground
Pin 2 -> Tx -
Pin 3 -> Rx +

http://support.renewedvision.com/pvp2wiki/index.php?title=File:DMXmoreoptions.jpg
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Pin 4 -> Ground
Pin 5 -> Nothing
Pin 6 -> Ground
Pin 7 -> Tx +
Pin 8 -> Rx -
Pin 9 -> Ground

Deck Control Master DB-9, usually Male
Pin 1 -> Ground
Pin 2 -> Rx -
Pin 3 -> Tx +
Pin 4 -> Ground
Pin 5 -> Nothing
Pin 6 -> Ground
Pin 7 -> Rx +
Pin 8 -> Tx -
Pin 9 -> Ground

These pinouts were originally used on tape based playback decks and have since been used on media servers and video
switchers as well. The Deck Control Master pinout would typically be found on a controlling device such as an editor or
video switcher. The Deck Control Slave pinout would typically be found on a playback deck that is to be controlled via
serial.

There are two common types of RS-422 computer interfaces you might run into. One is the serial port on video hardware
such as BlackMagic Decklink cards or Ultrastudio 3D devices. There are other similar devices such as those made by
AJA which also have RS-422 ports, however we have discovered that AJA does not properly set their serial port
configuration. In at least some of their devices (namely the ioXT), the serial port is fixed to a certain baud rate, parity, etc.
and cannot be changed, as confirmed by AJA. Unfortunately, none of the manufacturers we talked to really support the
serial port on their video hardware as a general purpose serial port, they tend to only support it when used with their own
software. However, we found that the serial port on BlackMagic hardware was very reliable.

The other common RS-422 interface is a simple RS-422/USB adapter. Note that this is not the same thing as (and not
compatible with) an RS-232/USB adapter which is much more common. RS-422/USB adapters are typically designed for
use in computing environments rather than video production environments, therefore they will typically have a pinout that
differs from the two specified above. In our limited testing, we have had mixed results with RS-422/USB adapters. There
are also RS-422/RS-232 converters which may work in conjunction with a common RS-232/USB adapter. We have not
tested this setup.

Serial ports that are found on video hardware interfaces such as those made by BlackMagic typically have a Deck Control
Master pinout configuration. When using the VDCP, AMP or Sony BVW protocols to control video playback in PVP, 2 the
computer's serial port needs to be a Deck Control Slave configuration instead. This requires a custom cable or the use of
adapters to switch the transmit and receive pins. When using GVG100 or Sony BVS editor protocols to control a video
switcher, the editor port on a video switcher typically matches the Deck Control Slave pinout so this works with a
BlackMagic serial port with just a straight through serial cable.

One of the easiest ways to create the necessary DB-9 cable for whatever pinout you need, is to use two DB9/ethernet
adapters connected with a straight thru ethernet cable. These inexpensive adapters are available from monoprice
DB9M/RJ-45,Modular Adaptor (http://www.monoprice.com/products/product.asp?p_id=1151) DB9F/RJ-45,Modular
Adaptor (http://www.monoprice.com/products/product.asp?p_id=1152)

The adapters come ready to assemble. You insert the colored leads from the ethernet jack into the appropriate pins of
the DB9 connector. Here is a common configuration used to swap the transmit and receive lines for using a BlackMagic
serial port as a Deck Control Slave with the VDCP, AMP or Sony BVW protocols in PVP 2:

Adapter 1: DB9 Pin 1 <-> White 
DB9 Pin 2 <-> Blue
DB9 Pin 3 <-> Yellow
DB9 Pin 4 <-> Red
DB9 Pin 5 <-> Nothing
DB9 Pin 6 <-> Green
DB9 Pin 7 <-> Orange
DB9 Pin 8 <-> Black
DB9 Pin 9 <-> Brown
(Colors are the Ethernet leads.)

Adapter 2:
DB9 Pin 1 <-> White
DB9 Pin 2 <-> Black
DB9 Pin 3 <-> Orange
DB9 Pin 4 <-> Green
DB9 Pin 5 <-> Nothing
DB9 Pin 6 <-> Red
DB9 Pin 7 <-> Yellow

http://www.monoprice.com/products/product.asp?p_id=1151
http://www.monoprice.com/products/product.asp?p_id=1152
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DB9 Pin 8 <-> Blue
DB9 Pin 9 <-> Brown
(Colors are the Ethernet leads.)

The goal in creating the proper cable is to connect the Receive lines Rx-/Rx+ with the Transmit lines on the other end Tx-
/Tx+, as well as connecting the ground pins. The polarity of the Rx/Tx connection should match, so Rx- should be
connected to Tx- and Rx+ should be connected to Tx+. This process is the same regardless of what serial interface you
are connecting to. For RS-422/USB adapters or other RS-422 serial ports, you may need to consult the documentation
for your device to get the pinout.

CITP/MSEX

PVP 2 officially supports the CITP/MSEX protocol. This protocol allows you to have a much higher level of control over
PVP 2 as a media server from your lighting console. If your lighting console supports CITP/MSEX, you can preview
thumbnails from PVP 2 directly on your console. At this time, we don't support the streaming aspect of CITP, just the
sending of thumbnails and clip names.

CITP/MSEX is added in Preferences on the Communications tab. Click on the Add Device button and select it from the
list. After you add the device, you will need to set the configuration needed for your console. Click on Save and then
Connect.

(/pvp2wiki/index.php?title=File:CITP-protocol.png)

MIDI

The MIDI configuration allows you to auto-fill all the commands from a starting note, or you can assign any MIDI note to a
given command. You must ensure that you don't assign the same MIDI note to multiple commands since this will result in
undefined behavior. MIDI connections are supported for any CoreMIDI device. Network devices may be configured via
OS X's Audio MIDI Setup utility.

Audio MIDI Setup is found in /Applications/Utilities in the Finder. After you have opened Audio MIDI Setup, click on the
Window menu and select Show MIDI Window.

Double-click on the Network icon on the MIDI Studio screen.  After you double-click on Network, you will see the MIDI
Network Setup panel. This is where you create your session that will allow your MIDI controller and your Mac to interact.
The screen shot below shows the completed configuration; the steps below the screenshot will guide you through the
setup.  To setup your session, click on the plus (+) button under My Sessions. This will create a default session titled
“Session 1”. This name doesn’t matter so you don’t need to change it. Check the box next to “Session 1”. After a few
moments, you will see available devices in the Directory listing. Select the device and click Connect. Change the Who
may connect to me option to Anyone. Verify that Enabled is selected at the top of your Session settings. You do not need
to make any other changes. Do not select anything for Live routings or your connection may not work properly.

Now that you have configured Audio MIDI Settings for your Mac, you are ready to setup PVP 2’s MIDI controls.

Return to PVP 2 and the Communication Module settings in Preferences. Click on the Device menu in the lower-right
corner of the module and add a new MIDI device. Select the correct device that you have setup to be used with your
Mac. Click Save and then Connect after you have finished configuring the rest of the MIDI settings.  Click on the MIDI
Setup button to open the MIDI communication settings. MIDI notes range from 0 to 127. Entering a number next to Auto

http://support.renewedvision.com/pvp2wiki/index.php?title=File:CITP-protocol.png
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Fill and then clicking the button will fill all of the values beginning with your chosen value. If you want each section to start
at a different, type your starting value in the first box of each list and then click the Auto Fill using the first value in each
Form at the bottom.

MIDI values cannot be shared between commands. For example, you could not assign All: 48 and Next Playlist: 48 at the
same time.

Outputs
ProVideoPlayer 2 provides a lot of control over your screens. To access the Layout Editor, click on the View menu and
select 'Edit Layout...'. You can also use the keyboard shortcut which is Shift-Command-L. If you have the Layers shown,
you can click on the 'Edit' button.

Before you get started, you may want to customize the Layout Editor. You can change the zoom level as well as the grid
settings at the bottom of the window.

(/pvp2wiki/index.php?title=File:OutputsLayoutEditor.png)
Most users will likely be using PVP 2 with a single output. We will cover setting up multiple outputs later, so let's focus on
one for now.

The screenshot above shows the initial Output layout. PVP 2 is running on an iMac that is connected to a 1920x1080.
Since the two displays are positioned left (iMac) and right (SyncMaster), the second screen is positioned relative to that.
As you can see, the screen is 1920x1080, and starts 1920 pixels to the right, allowing space to add the other output to
the left if desired. For a single output, the position is not as import as it is if you have multiple outputs enabled.

The Output settings on the right side of the window give you several adjustment options and advanced settings for your
output.

The top section shows you the general arrangement of your displays. This is based on the System Preferences display
arrangement. You can click on the screen that you want to assign your Output to.

Below that, you can give the Output a unique name if you need to. As mentioned above, the X and Y axis position is set
automatically. If you have more than one screen, you can adjust these numbers (or drag the Output) to get the screen in
the correct position.

The width and height are based on the detected or custom resolution. You can change the numbers here or by resizing
the output using the handles on the Output.

Edge Blending, and Corner Pinning will be covered individually in more detail in other sections.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:OutputsLayoutEditor.png
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PVP 2 can handle multiple outputs at the same time. If you have more than one video card or multiple Blackmagic
Thunderbolt devices, you can add those as additional outputs. To add more outputs, click on the action menu in the
lower right corner and select 'Custom Output' from the list.

(/pvp2wiki/index.php?title=File:AddCustomScreen.png)

This will open a new window at the top of the screen that will allow you to create your new output. In the example below,
a new triple-wide screen is shown being added.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:AddCustomScreen.png
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Advanced Output Configurations
PVP 2 is capable of being networked on multiple Macs. Each computer can run one or more displays. If you have to
setup several computers, it can be a tedious task to make sure you have your outputs configured properly and that the
correct segments of a video or image is showing on the proper screen.

With PVP 2, we have tried to make this task a bit easier for you. As shown in the image below, you can drop a drawing or
picture of your set directly into the Layout Editor. This gives you the visual guide for where each of your outputs need to
be positioned. (Normally there will be a default Output already shown when you add your image, but it was removed for
illustration purposes.)

http://support.renewedvision.com/pvp2wiki/index.php?title=File:SetCustomScreen.png
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(/pvp2wiki/index.php?title=File:OutputDrawing.jpg)

As you can see, there are multiple screens that will be used for this stage. There are two ways to create this layout. You
can either split the existing output screen in the Layout Editor, or you can use the Setup Wizard. Both methods are shown
here. The end result will look similar to the screenshot below.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:OutputDrawing.jpg
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Setup Wizard Open the Setup Wizard from the View menu. Since the screen setup in the example below requires a 12
screens setup in a grid pattern, change the number of screens and the layout option. Don't worry about how the grid is
drawn on this screen because you'll be re-arranging the screens in the Layout Editor.

(/pvp2wiki/index.php?title=File:SetupWizard12Screens.jpg)

Corner Pinning
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Corner Pinning makes it much easier to fine-tune the edges of your output if necessary when you need just a little bit
more of an adjustment than you can get out of your projectors. Before you rely on Corner Pinning, you will want to make
sure your projectors are as close to properly aligned and positioned as you can. The projector's physical position (along
with keystone and cornerstone angles, lens shifting, and zooming) should be adjusted as much as possible to create a
properly aligned image.

Corner Pinning allows you to freely move the corners of an image to adjust for the skew between a projector and
projection surface, typically a screen. To access this feature, open the Layout Editor and select the Output that you need
to adjust on the Output tab. After you selected your Output, check the box next to "Enable Corner Pinning" to the right.

(/pvp2wiki/index.php?title=File:Corner-pinning.jpg)

Once you have enabled Corner Pinning, a purple overlay will be added to your Output to help you position your corners.
Click the white handles on each corner to adjust your Output. To lock in your settings, click the "Edit Corners" button. If
you need to reset your corners, click the "Reset" button. Unchecking the box next to "Enable Corner Pinning" will turn off
Corner Pinning, but it doesn't reset the corners when you re-enable the setting.

Corner Pinning updates the live output in real-time, so you can have an image or video showing and see your
adjustments while you're making them.

Organizing Media
The left side of the program is the Playlist manager. This area contains your Library, Live Video cues, Playlists, Group
Folders, and Hot Folders.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:Corner-pinning.jpg
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Library
The Library lists all media files that have been added to PVP 2, with the exception of media in Hot Folders. Any media
that you add directly to a Playlist will appear in the Library.

Live Video

(/pvp2wiki/index.php?title=File:LiveVideo.jpg)

PVP 2 has great support for Live Video. If you have cameras connected to your Mac and need to be abel to access them
through ProVideoPlayer 2, be sure to check the "Show Live Video Playlist". This playlist is the only way to access
connected displays. We support most Blackmagic Design Thunderbolt and PCIe cards for input. USB and Firewire
interfaces can also be used, but support for these devices is limited, and the quality won't be as high. You will also
experience higher latency with USB or Firewire devices.

To add a camera, select the Live Video playlist, then click the plus button at the bottom of the program window. This will
print up a selection window that allows you to pick which input device you want to use. PVP 2 supports multiple cameras
if they are available. Cameras can be assigned to specific layers just like any other media file.

While PVP 2 does have support for video cameras, and for multiple cameras, PVP 2 doesn't not replace a video switcher.
If you have multiple cameras, it is best to still use a video mixer with someone responsible for calling shots and taking
them. You could connect the program feed of the mixer into PVP 2 if you wanted to using a Blackmagic device.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:Playlists.jpg
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Playlists
Playlists are the most basic way to organize your media files. Outside of the Library, Playlists are the only way to directly
sort and organize your files. You can add a new playlist from the menu at the bottom of the playlist manager on the left
side of the program, from the File menu, or with the keyboard shortcut.

Group Folders
Group Folders are used to organize your Playlists. Content cannot be added to a Group Folder, only Playlists. A Group
Folder can be added from the menu at the bottom of the playlist manager on the left side of the program.

Hot Folders
Hot Folders are similar to Playlists, except they watch a folder on your computer. Rather than adding content directly to a
Hot Folder inside of ProVideoPlayer 2, the content is added to the folder being watched. This is useful if you have a folder
of content that isn't consistently being used or need to watch a shared folder that others are adding content to.

Shows
If you are familiar with the first version of ProVidePlayer, you'll remember that every show you used PVP 2 for you had
either had to create new playlists or start from scratch. With PVP 2 we've added the ability to create new "Shows". A
show contains all of the Playlist, Media, Effects, and Networking information that is created. You can always work with
the default show, or you can create multiple new shows from the File menu.

These files are stored in your Documents folders by default, but you can select any location to save your files. Loading a
Show file will change all of the content, layout settings, and network settings that are associated with that Show.

Media Effects

http://support.renewedvision.com/pvp2wiki/index.php?title=File:PlaylistMenu.jpg
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PVP 2 comes loaded with effects that you can apply to videos and images. These effects can even be applied to live
video inputs. By using these effects, you can create an endless variety of media without having to create entirely new
files.

Media Effects can be added at three layers: Workspace, which is the global setting; Layer, which is for anything playing
on that Layer; and per clip, which only changes that one cue. All effects are available at each level. The more specific the
effect, the higher its priority. Workspace effects are used first, a Layer effect takes priority over that effect, and a cue
effect takes priority over both.

Since these effects are better explained by seeing them in action, individual effects will not be covered. The screenshot
above shows the complete list of effects that are available.

When you check the box next to an effect name you will activate the effect and open the settings drawer. Most effects
have several adjustments available for you to tweak the way that effect is applied. Clicking on the name of the effect will
also open the settings drawer, but you will not see the results of the effect until you enable it by checking the box to the
left of the name.

If you click on the 4x4 grid to the right of an effect's name, you can drag it to change the order of effects in the list. You
may want to do this if you find there are certain effects you're always using and want them to be closer to the top of the
list.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:Mediaeffects.jpg


3/3/14 12:16 AMPVP 2 Wiki

Page 26 of 43http://support.renewedvision.com/pvp2wiki/index.php?title=Contents

Effect Sets allow you to create layers of effects that can be applied simultaneously. To create a new Effect Set, select and
adjust the effects you want to use, then click on the "Save Set" button in the bottom right corner of the program window.
This will create a new Effect Set. You can change the default name to something more descriptive. To use the Effect Set,
simply double-click on the set. If you mouse over the set you can click on the Disable button to turn off the set.

You can drag any effect or Effect Set onto a particular cue in the current playlist to set a cue level effect. You can also
apply cue effects by right-clicking on the cue and selecting "Media Cue Inspector".

(/pvp2wiki/index.php?title=File:CueEffects.jpg)

If you want to take advantage of the effects to create several varieties of a specific media cue, just copy/paste the cue, or
drag it from your Library into a Playlist several times. You can then modify each instance of the cue to look the way you
want. Doing this does not create multiple copies of the actual file on your computer, it just creates new versions of the file
within PVP 2. You can have 10 copies of a 1MB video file in PVP 2 and it will still only take 1MB of space on your hard
drive.

Macros
Macros make changing content on multiple layers as simple as clicking on one cue. To get started with Macros, click on
the "Macro" button in the toolbar at the bottom of the program. This will add a new Macro to the end of your Playlist.

(/pvp2wiki/index.php?title=File:Macros.jpg)

Select and drag the files that you want triggered by the Macro on the Macro cue. After you add the cues, the Macro
options window will appear. From here, you can name the Macro set, as well as assign transitions for each clip in the
Macro. You can read more about how transitions are handled by Macros in the Transitions section. Since Macros are
intended to be used with multiple layers, select the layer that you want each clip to be shown on. As you select a layer, it
becomes unavailable for other clips to prevent you from accidentally doubling up on an assignment.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:CueEffects.jpg
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Layers
Layers in PVP 2 can really expand what you're able to do with the program. Whether you are using one screen, or
multiple screens, Layers will allow you to show multiple videos at once, or to create some really cool visual effects.

A Layer is just another video channel in PVP 2, not a dedicated output, so they are especially useful in a single screen
environmental.

The screenshot below shows a single output with seven Layers. Layers are order from back to front, when looking at the
available Layers from left to right. In the example below, Layer 1 is the background image. Layers 2 through 7 are event
advertisements.

Creating the initial layer is simple. Open the Layout Editor, click on the Layers tab, and start adding Layers. You can drag
the Layers into the order that you want them, as well as renaming them in the top-right box. You can also change the
border of the Layer. This is used for your reference only. There is no limit to the number of Layers that you can add to the
program.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:MacroOptions.jpg
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Each layer can have multiple Targets. Targets will be covered in additional detail later. However, for the purpose of
demonstrating Layers, the screenshot below shows two Layers. The Target on the second Layer has been made smaller
to similar a Picture-In-Picture (PIP) effect.

(/pvp2wiki/index.php?title=File:TargetLayers.png)

PVP 2 will always have at least one Layer. In order to see and use the additional Layers that you create, you will need to
show the Layers. The available Layers can be shown at the top of the thumbnail view by pressing Command-L or
selecting 'Show Layers' under the 'View' menu. You can see this section at the top of the screenshot above. Two layers,
"Background" and "Top Left Ad" are shown.
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Another powerful feature available in PVP 2 is the ability to use Macros, which are pre-grouped sets of media that can be
triggered by a single cue. Macros will be covered in more detail later, including how to take advantage of Macros and
Layers.

Each Layer can also have its own set of Effects applied.

Targets
Targets are used within Layers to specify where you want your content to be displayed. By default, each Layer starts with
one Target that is the same size as the Layer. For many users, this may be all that is required. This is shown in the image
below.

(/pvp2wiki/index.php?title=File:LayoutLayersTarget.png)

You can also work with multiple Targets within each Layer. There are two ways to add multiple Targets. You can right-
click on a single Target and select "Divide Target". This will bring up a box at the top of your screen that will allow you to
split the Target into multiple smaller targets

Target Sets
Target sets allow you to create multiple Target layouts for each layer. If you use PVP 2 in several different configurations
from show to show, or even within a show, Target Sets, combined with Looks, give you a lot of flexibility.

As you can see in the two images below, there are two Layers with multiple Target Sets. By default, Target Sets is
collapsed, so click on the reveal arrow to access the list and add new sets. Creating Target Set is identical in process to
adding multiple Layers with different targets. The difference here is how they used. Using Target Sets is covered in the
Looks section.
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Looks
Looks give you a lot of control over what happens on your screens during a presentation. Rather than being limited to
one single look throughout your show, you can create as many Looks as you want. If you have set pieces that are moving
around or you're using PVP 2 to control scenic/environmental elements, Looks can make your job a lot easier.

Looks are driven by Layers and Target Sets. You can read more about each of these in their individual sections.

To create a new Look, you will need to enable the Looks button. To do this, press Option-L on your keyboard or by
selecting "Enable Looks Button" from the View Menu. This will add the Select Look button in the top-right corner of PVP
2.

(/pvp2wiki/index.php?title=File:LooksButton.jpg)

Click on the Select Look button and select Manage Looks from the dropdown menu. This will open a new window that
allows you to create your Looks.

(/pvp2wiki/index.php?title=File:ManageLooksMenu.jpg)
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To create a new Look, click on the plus button under the Looks column on the left. Give your new Look a name. This
name is how you will identify what each look is for.

Once you have created your Look, you can add Layers and select the Target Set to be used. You can add multiple
Layers, but you can't have multiple Target Sets in use for each Layer within a single Look. To use the same Layer with
different Target Sets, you will need to create multiple Looks. Click the plus button with the down arrow in the lower-right
corner to add a Layer. After you add a Layer, you can change which Target Set is used.
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The two screenshots below show the same two menus as above once you have added new Looks. The second
screenshot shows the Looks button and the menu after a Look as been selected. Also, note that each Look is given a
keyboard shortcut to make it easier to change which Look is being used.

(/pvp2wiki/index.php?title=File:ManageLooksEditor.jpg)
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Masks
There may come a time when you need to project content onto a surface that is an abnormal shape, or that has areas you
don't want to cover with a projected image. This is where Masks come into use. Through the use of Masks, you can black
out portions of your screen using the built-in drawing tools, or by importing a PNG file with transparent sections.

Masks are located in the Layout Editor.

PVP 2 has three drawing tools: Freehand drawing with a bezier curve, squares, and circles. Masks can work as an
Overlay where it blacks out a portion or the screen, or as a Keyhole, that allows the signal through the shape.

The Stroke and Fill colors are just for your reference in the Mask editor. Masks do not display any color, they simply black
out part of the signal coming from ProVideoPlayer 2.

You can also feather the edges of your mask to soften the transition of the Mask layer.

Edge Blending
Manual Setup

Assistant

Transitions
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ProVideoPlayer 2 includes a variety of stock transitions for you to use. The basic cut and dissolve are still available, but
now there are many more transitions that you can use to add variety to your presentations if you want to.

Transitions can be set at two levels: Layers or Clips.

Layer transitions are set at the bottom of the program window, and are used globally for all Layers when changing clips.
To change this transition, open the transition menu located in the toolbar at the bottom of the program and select the
transition you want to use. Each Layer will use this transition, but only when the Layer is active. If you have multiple
Layers, only the currently Layer changes.

(/pvp2wiki/index.php?title=File:LayerTransition.jpg)

If you want to set a specific transition to be used for individual files, you can either right-click on the file and select the
Transition menu, or you can open Media Properties and change the transition.

(/pvp2wiki/index.php?title=File:ClipTransition.png)
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Macros handle transitions slightly different. By default, a Macro uses the transition set for Layers. Since a Macro triggers
multiple layers at one time, all of the layers will transition in using the current transition. You can also select specific
transitions to be used for each Layer added to a Macro. When you set a specific transition for a Layer, that will be the
transition used for that layer every time the Macro is selected.

(/pvp2wiki/index.php?title=File:MacroTransitions.png)

All layers transition out with the layer used to bring the current media file on screen.

Mapping
This section is for showing advanced mapping that is not covered in the Layout Editor section.

Network
Many ProVideoPlayer 2 users will only need a single computer to drive their single screen set ups. With PVP 2, additional
graphics cards will greatly expand that functionality, however, for large projects a single machine is not capable of
delivering the number of pixels you desire. PVP 2 allows you to network multiple machines together and will deliver frame
accurate playback across multiple machines. You can view the network connection status in real time in the network
panel.

The most exciting new addition to networking is the ability to push content from the Master machine to the Slave
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machines. Content includes actual video files, playlists, folders, and even output position, layers, and targets. This means
you can set up your 20 outputs on the master machine, set their position relative to each other, drop in your layers and
targets, push your content across the network, assign outputs and be up and running in no time. Never before have multi-
screen presentations been so easy!

Configuring the Network
To connect your computers together, click on the "Network" button in the top right corner of the program. On each
computer you will need to specify whether the computer is the "Master" or "Slave" computer. In order for a "Master"
copy of PVP 2 to connect to another computer, the PVP 2 must be set to "Slave" on the other computers. You cannot
connect a "Master" to a "Master" or a "Slave" to a "Slave".

(/pvp2wiki/index.php?title=File:Master-SlaveList.jpg)

There shouldn't be a reason to change the name or the port being used to connect. If you have had to open a specific
port for PVP 2, then you will need to update the number on each computer to use that port.

If there are other PVP 2 Slave computers available, they will be listed, as shown in the image above. Click the "Connect"
button to establish a connection.

Once connected, your Master and Slave computers will indicate they are connected. The Slave computer will also show
you the quality of the connection. It make take a few moments to stabilize and report a good connection. While
networking does work over wi-fi, we strongly encourage using a hardwired, dedicated network when setting this
up for live production.

(/pvp2wiki/index.php?title=File:Master-SlaveConnected.jpg)
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You can select to have the Master computer automatically connect with each computer when it becomes available. This
option is useful if you need to restart computers and want to make sure everything gets reconnected without having to
manually reconnect each system.

The "Accept Slides" option is part of the Text Stream feature and covered in more detail in that section.

Clone Master to Slaves
Typically if you are using PVP 2 Network Nodes, you also need to have some or all of the same content on each
computer. The "Clone Master to Slaves" function makes this easy for you. To use this function, open the "Network" menu
at the top or your screen and select "Clone Master to Slaves". This process will begin transferring all of your playlists,
media, and layout settings to each computer.

(/pvp2wiki/index.php?title=File:CloneMasterToSlaves.jpg)

The biggest benefit that this provides is that you can essentially program all of your slaves and the the outputs that will be
attached to them from one computer. After you have cloned your settings to each slave, you will be able to open the
Layout Editor and connect the appropriate displays. You may need to make small adjustments to your Outputs, Layers,
and Targets, but you won't have to recreate everything from scratch on each slave computer.

You can monitor the the progress of file transfers by selecting "Show Transfers" from the Network menu.

Managing Network Nodes

Text Stream
(Note: Text Stream requires the latest version of ProPresenter 5 for Mac or Windows.)

When you enable Text Stream in ProPresenter 5 and PVP 2, you are able to take the text layer from ProPresenter 5 slides
and integrate it as a layer in PVP 2. This allows you to have really elaborate video configurations along with dynamic
content from ProPresenter 5.

Enable this option in ProPresenter 5

Enabling this in ProVideoPlayer 2 is a two-step process. First, you will need to enable PVP 2 to receive a text stream in
Preferences. Second, you will need to enable the actual Text Stream layer in the Network settings.
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To access the Scheduler, select it from the View menu or press Control-S.

PVP 2 includes a Schedule so that you can setup presentations to run automatically. Schedules are made of three
elements: Schedule, Action, and Event.

Schedules contain Actions and Events trigger Schedules.

For example, say that you need to setup PVP 2 to run a different schedule every day of the week. You would create a
new Schedule for each day of the week.

Each day you may need to trigger a morning and an afternoon playlist. This is what Actions are for. For each Schedule,
add the two Actions and select the playlist and set the time that you need each Action to begin.

Events are used to trigger a schedule. In this scenario, you would need to create seven Events. Each Event would trigger
the specific Schedule for that day. You can set a Schedule to repeat daily or weekly.

You can disable the Scheduler if you need to use PVP 2 during the time a schedule would normally run. When a Schedule
is active, you will see a Clock in the top right section of the program to indicate there is an active schedule.

Key Mapping
ProVideoPlayer 2 gives you completely control over hot keys to trigger a number of actions within the program. To enable
custom hot keys, open the 'View' menu and select 'Learn Key Mapping'. When you turn on 'Learn Key Mapping', the
areas that can be mapped will turn purple.

http://support.renewedvision.com/pvp2wiki/index.php?title=File:Schedule.jpg


3/3/14 12:16 AMPVP 2 Wiki

Page 39 of 43http://support.renewedvision.com/pvp2wiki/index.php?title=Contents

(/pvp2wiki/index.php?title=File:Keymapareas.png)
To assign a custom key (A through Z, and symbols) click on the item you want to assign a key to, and press that key. As
you can see in the image below, a few of the items have been assigned various keys.

(/pvp2wiki/index.php?title=File:Keymapping.png)

Once you have assigned the keys that you want to use, click on the 'View' menu and select 'Stop Key Mapping'. This will
remove the purple overlay from the screen and you will see indicators on each item to remind you which key is assigned.
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Menu Bar
Most of the menu options are self-explanatory. Menu options that apply to a specific section of the manual are linked to
those sections for further explanation.

ProVideoPlayer 2 Menu
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Window
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Troubleshooting
There may be a time when you need to do some basic troubleshooting in PVP 2. The steps below outline where all of the
files are stored, what they control, and when you may need to remove one of those files.

Before you remove any of these files, you should make sure PVP 2 is closed completely. If the program won't close
normally, click on the Apple menu, select Force Quit, then quit ProVideoPlayer 2. We also recommend moving the file to
your Desktop, or simply renaming the file by adding "-old" to the end of the file name. Moving or renaming the file will
cause PVP 2 to ignore the file and create a new one the next time the program opens. If you move or rename a particular
file and it doesn't correct the issue you're trying to resolve, delete the newly created version of the file, and restore the
original file. Again, make changes to the files while the program is closed.

ProVideoPlayer 2.app

The program itself is generally located in your ~/Applications folder. (The tilde '~' stands for your user folder in a file path.)
It's rare that uninstalling and reinstalling the application is needed during troubleshooting as a step by itself. However, it is
sometimes recommended to ensure you have the latest version of the program installed.

Preference file

(/pvp2wiki/index.php?title=File:PVPpreferencefile.jpg)

The preference file, com.renewedvision.ProVideoPlayer 2.plist, is stored in ~/Application Data/Preferences. This file
exists on every computer that PVP 2 has launched on. The preference file for any application in OS X is frequently the
silver bullet to fix a problem when nothing else makes sense. A number of settings related to the application are
maintained in the preference file, including settings in Preferences, the physical arrangement of the program's user
interface, transition and effects settings, and other program settings. It is generally recommended to try this file first in the
troubleshooting process. We suggest dragging the file to your desktop rather than deleting it to ensure it solves the
problem you're attempting to resolve. If it does not, quit ProVideoPlayer 2 and move the file back into the Preferences
folder. You may have to replace a newer file; go ahead and do so.

Program data files
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Most of the files used by ProVideoPlayer 2 are stored inside your ~/Documents folder. By default, the first show that gets
created is called "ProVideoPlayer Show", so you would find ~/Documents/ProVideoPlayer 2/ProVideoPlayer Show in the
Finder. If you create new shows in PVP 2, you can choose to save them in ~/Documents/ProVideoPlayer 2, or anywhere
else that is convenient for you. The same files will be created as shown in the screenshot above, but the location will be
different. If you want to delete an old show, simply delete the folder for that show to remove all of the information
associated with it.

The cache folder contains thumbnails for all of your media files that you have added to PVP 2. These files are normally
handled automatically by the program when you add, remove, or modify a file. If you are having trouble with thumbnails
not updating or displaying properly, you can safely delete this folder while the program is closed. When PVP 2 is opened
again, it will rebuild all the necessary thumbnails for the files that still exist in the program. If you have a lot of files, this
may take several minutes.

The commModuleDevices.xml only exists if any Communication Modules have been activated in Preferences. Remove
this file to remove the active modules if you're having trouble with them. This file contains all the settings for each module
you have selected. Normally you should be able to remove a module from Preferences>Communication, but if you're
unable to, then you will need to remove this file.

The effectsPresets.xml file contains all of the Effects Sets that have been created. If you've created a number of Effects
Sets and don't want to delete them individually, but would prefer to remove all of the Sets at one time, you can delete this
file.

The playlists.xml file contains all playlists and the content included in those playlists. This will remove everything except
for Library and Live Video, if enabled. On rare occasions, this data may become corrupt, generally because of bad media
files being added to a particular playlist, or because changes to a playlist didn't save properly. This file contains a lot of
information. It lists every playlist, as well as every clip and clip properties within the playlist.

The slaves.xml file contains the list of active slave computers. If you have never connected PVP 2 to another computer,
then this file would be empty. It is unlikely that you would need to remove this file unless you're having trouble getting
Slave computers to connect.

The workspace.xml contains all of the settings related to Outputs, Edge Blending, Layers, Targets, etc. If you are having
significant trouble with your Layouts, or you need to start over with all new Layouts without having to build new Playlists,
you can remove this file.

ProVideoPlayer Media

This folder is stored in your Shared user folder. To locate it, open the Finder, press Command-Shift-G, then navigation to
/Users/Shared/. The ProVideoPlayer Media folder contains your media files, organized by type. If you have selected
"Manage Media Automatically" in Preferences, all of your media can be easily found here. Any media that you have
imported as part of a playlist, or transferred from another instance of PVP 2 over the network, will also be found here. If
you added a file to PVP 2 from the same computer, you will see two "copies" of the same file: the original file and the one
in the media repository. The file in the media repository is not a true duplicate of the original file, but a link to the data on
your hard drive. If you move or delete the original file, you won't remove this file by accident, you just remove the other
link to the same data.
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